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Minimum System Requirements for Windows 95

* A 100% Windows 95-compatible computer system (including 32-bit Windows
95-compatible drivers for CD-ROM drive, video card, sound card and input devices).
Intel Pentium® 75 MHz processor

VESA local bus (VLB) or PCI video

256-color SVGA (640 x 480)

16 MB RAM

Double-speed CD-ROM drive (300K/sec. sustained transfer rate)

Hard disk drive with 62 MB of uncompressed space available

Windows 95 operating system

100% Microsoft-compatible mouse

100% Sound Blaster-compatible sound card

Dedicated game card highly recommended for joysticks

Supports any 100% Windows 95-compatible input device, including but not
limited to:

Microsoft Sidewinder Joystick; CH Flightstick Pro and Virtual Pilot; Gravis Analog
Joystick, Analog Joystick Pro and Gamepad; Thrustmaster Flight Control System

Important Note:

The Windows 95 version uses new Microsoft DirectX technology, which requires your
system to be able to fully support DirectX. If your system does not support DirectX,
we suggest trying the MS-DOS version.

Minimum System Requirements for MS-D0S

IBM PC or 100% compatible

Intel® 486DX2/66 MHz processor

8 MB RAM (7 MB of free extended memory)
Double-speed CD-ROM drive (300K/sec. transfer rate)
Hard disk drive with 62 MB of uncompressed space available
VESA local bus (VLB) or PCI video

256-color SVGA (640 x 480)

MS-DOS 6.22

100% Microsoft-compatible mouse and driver

100% Sound Blaster-compatible sound card

Dedicated game card highly recommended for joysticks

MereNet (which is included), in addition, requires one or more of the following:

e Novell™ Network

¢ Novell-compatible IPX network

* 100% Hayes/MS-DOS-compatible modem (9,600 bps for head-to-head play. 14,400
is recommended.)

e Null-modem cable and serial port with 16550 UART

* Internet Play: 14,400 bps modem, MS-DOS packet driver and Internet
Service Provider

Supported Sound Devices:

Creative Labs Sound Blaster Basic, Pro, 16 and AWE 32; Media Vision Pro Audio
Spectrum Basic, Plus and 16; Gravis Ultrasound; Ensoniq Soundscape; Roland MT-32;
General MIDI devices

Supported Input Devices:

Standard two-button joysticks; CH Flightstick and ProPedals; Thrustmaster flight,
weapons and rudder control systems; Thrustmaster F-16 Flightstick; Gravis gamepad
and Phoenix joystick; Virtual I/0 i-glasses; Suncom Technologies SFX gamepad;
Microsoft Sidewinder joystick




INSTALLING MERCENARIES FOR WINDOWS 95

Please make sure your computer system is 100% Windows 95-compatible.
MechWarrior 2: Mercenaries for Windows 95 is not compatible with Windows
3.1 or other operating systems.

Note: For MechWarrior 2: Mercenaries for Windows 95 to operate the best,
it requires that your system have the latest Windows 95 drivers for your
CD-ROM drive, sound card and video card, as well as any other peripherals
you want to use (e.g., joysticks). If you have any problems running the
program, older sound or video drivers are the most likely cause.

If you need help on how to obtain the latest sound and video drivers,
check out our Technical Help file. Just press the More button on the
MechWarrior 2: Mercenaries title screen (the title screen displays shortly after
inserting the MechWarrior 2: Mercenaries for Windows 95 CD into your
CD-ROM drive), then click the Help button. We have supplied a list of major
computer hardware companies and their telephone numbers. You can find
them listed under Vendor List. This file has a lot of other helpful information
on installation and system setup, as well as game-specific technical help.

How to Install the Windows 95 Version

1. Before installing, close all other applications. Also make sure Virtual
Memory is on (located in your System Control Panel).

2. Insert the Mercenaries CD into your CD-ROM drive and wait a few
moments until the Mercenaries title screen appears. (If the title screen
does not appear, please refer to “AutoPlay” in the Troubleshooting
section.)

Windows 95 4

3 There are four buttons on the title screen. Click the Install button to begin
the installation process and then follow the on-screen instructions.

After Mercenaries setup is complete, your computer will install the
Microsoft DirectX 2 drivers if you do not already have them. When DirectX 2
installation is complete, you will need to restart your computer for the new
drivers to take effect. For more information on DirectX 2, see page 8 of this
manual.

Now you can run Mercenaries for Windows 95 by choosing
Programs/Mercenaries/Mercenaries from the Start menu or by clicking
Play on the CD title screen.

Please register your copy of Mercenaries. To make it easy and fast you
can use our Electronic Registration system. There are two ways to access
the system from the Mercenaries title screen: (1) click on More, and then
click on Electronic Registration or (2) right-click on the Mercenaries CD
icon and select Electronic Registration.

Title Screen Button Functions
Install — Installs the game.

Play - If the game has already been installed to your system, click this
button to play Mercenaries for Windows 95.

More — Click this button to access the Electronic Registration, Help, About
Activision and Uninstall buttons.
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. What is DirectX 2 and why do | need it?

. Microsoft’s DirectX 2 is a set of functions that gives Windows 95 games
and other applications their power. Using these functions allows
applications to perform advanced functions in networking, graphics,
sound and input beyond what’s possible on other operating systems and
accounts for much of the performance gains associated with Windows 95
games. Mercenaries for Windows 95 uses DirectPlay, DirectDraw and
Directinput, three of the DirectX 2 functions.

. If | don’t have DirectX 2 will Mercenaries for Windows 95 install it
for me?

. Yes. If InstallShield does not detect DirectX 2 on your computer, it will
install DirectX 2 for you. After installation is complete, you will need to
restart your computer in order for DirectX 2 to take effect.

. | already have other Windows 95 games installed on my computer.
Will the Microsoft DirectX Installer change my DirectX files?

. If you already have other Windows 95 games on your computer, chances
are you already have the initial version of DirectX installed. In this case,
the Microsoft installer will detect and overwrite any previous versions
with DirectX 2. At that point, you will need to restart your computer for
the changes to take effect.

If, however, you already have DirectX 2 installed on your computer,
the Microsoft DirectX 2 installer will detect that and not overwrite any
DirectX 2 files. You will not need to restart your computer after
installation in order to run Mercenaries.

PROBLEM

Program won’t
install

Game doesn’t
start

Movies don’t
play properly

SOLUTION

You may have insufficient hard disk space for the
program to copy the files it needs from the CD to your
hard drive. Free up more hard disk space.

This problem may be caused by lost clusters on the hard
drive. Run SCANDISK to determine if this is the problem.
See your Windows 95 manual for more details on
SCANDISK.

* Make sure your system meets the minimum
requirements for the program, especially your CD-ROM
drive. The program requires a CD-ROM drive with a
minimum sustained transfer rate of 300K bps (a
double-speed drive).

* You may not have enough RAM to run movies. Check
to make sure you have sufficient RAM to run this
product. You need 16 MB.

* Too many other applications may be running. Close
down other applications (especially DOS boxes or
modem programs) and try again. We strongly
recommend that you not run other applications while
running Mercenaries for Windows 95.

» Make sure your display is set to 256 colors in the
Settings section of your Display control panel.




Game Previews — Click this button to see previews of some exciting
Activision games.

Exit — Click this button to close the title screen and exit Mercenaries for
Windows 95.

Help - Click this button to view the latest technical information not found in
this install guide.

About Activision — Click this button to view information on how to contact
Activision.

Electronic Registration — Click this button to register your copy of
Mercenaries for Windows 95 over the modem.

Uninstall — Click this button to remove all Mercenaries for Windows 95 files
from your computer.

Troubleshooting

Online Help :
We have supplied a technical help file that can help you in troubleshooting
problems. There are four ways to access this help file:

* Right-click on the Mercenaries CD icon and select Technical Help.
» From the title screen, click on More then Help.

« After installation, from the Start menu, select
Programs/Mercenaries/Mercenaries Technical Help.

* From within the game, select Technical Help from the Help pull-down
menu.

Windows 95 6

AutoPlay
If the Mercenaries title screen does not appear, try performing the following
steps:

1. Double-click on the My Computer icon on your desktop or right-click on
the icon and choose the Open option.

2. Select the Refresh option located in the View pull-down menu.

3. Double-click on the Mercenaries CD icon in the window or right-click on
the icon and choose the AutoPlay option.

4. After the Mercenaries title screen appears, click on the Play/Install button.

If the AutoPlay feature does not function, please check the following:
1. Make sure the CD is clean and properly placed in the CD-ROM drive.

2. Your CD-ROM driver may not be optimized for use with Windows 95. To
verify this, perform the following steps:

a. Open the Windows 95 Control Panel folder and double-click on the
System icon.

b. Click on the Performance tab. If any of your hardware drivers are not
fully optimized for use with Windows 95, they will be listed here with
an explanation of the exact problem and suggestions on how to fix it.

DirectX 2
Upon completion of the Mercenaries setup, the installation process will
continue by determining if Microsoft's DirectX 2 needs to be installed on your
computer. If so, the appropriate files will be installed on your computer
automatically.

7 Windows 95



PROBLEM

Movies don’t

play properly
(cont’d)

Game freezes

No sound,
partial sound or
no voices or
sound effects

Windows 95

SOLUTION

The movies will initially appear in minimized screens to
improve performance. If you have a fast video card and
CD-ROM, you may be able to run the movies in a full-
screen window. You can change to a full-screen window
by going to the pull-down menu bar, clicking on Options,
selecting Movie Playback and then choosing 640x480 for
your resolution. Movie playback at 640x480 may not
perform properly if you did not select the Mercenaries full-
blown installation.

» Make sure your computer has at least 16 MB of RAM.

» Make sure you are using Windows 95 with the latest
32-bit drivers for all your peripheral devices.

* Make sure you have a 100% Windows 95 (Sound
Blaster) compatible sound card in your computer.

* Make sure your speakers are plugged in correctly and
turned on, and make sure the volume is turned up to an
audible level.

* Make sure you are using the latest Windows 95 32-bit
sound drivers for your sound card.

» Make sure your audio card is properly installed and that
you have the correct audio drivers installed. Check your
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PROBLEM

No sound,
partial sound or
no voices or
sound effects
(cont’d)

Game too slow

SOLUTION

audio card’s installation and its setup parameters within
Windows to be sure all is correct. See your card’s
manual and your Windows manual for details.

» Make sure you are running Mercenaries for Windows
95 on a Pentium or higher system. Any 486 or lower
system usually will not perform at an acceptable speed.

* Try turning off some game options in the Combat
Variables screen.

* Make sure you have no other applications running in
the background.

» Make sure your screen resolution is set to 320x200 in
the Combat Variables screen.

1 Windows 95




INSTALLING MERCENARIES FOR MS-D0S

Before Installing

Here is some important information that you should know before you install
and start playing Merecenaries for MS-DOS. :

Hard Disk !
The game requires 62 MB of UN-compressed free disk space. Mercenaries \
will not work properly using compressed hard disk space (such as Stacker

and DoubleSpace). If you have the space, there are two other installation

options that require even more hard disk space, but allow animations and

movies to run even smoother.

Memory

In order to run Mercenaries you need over 6.9 MB of extended memory. If
you have between 6.5 MB and 6.9 MB of extended memory, the game will
play, but some missions will run slower. For optimal performance it is best
to configure your memory so you have over 6.9 MB of extended memory.
To help you free up more memory, we included a boot disk-making utility
that you will be prompted to use from the Installer.

Other Operating Systems and Windows NT

Mercenaries requires MS-DOS 6.22 or later. Other operating systems

(e.g., 0S/2 Warp and Windows NT) are not supported. Although Mercenaries
might work just fine with them, we have not tested thoroughly with them. If
you have a problem using unsupported operating systems, it is best to
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contact the operating system company to try and work out compatibility
issues. Please check Activision’s online forums on a regular basis for future
updates on Mercenaries compatibility issues.

VESA Video Drivers

Mercenaries requires that your system have a standard VESA video driver to
run your video. Please verify that you have one loaded before launching
Mercenaries. ;

If the VESA driver supplied by your video card does not function
properly with Mercenaries, try using the UniVBE VESA driver. This is
available for downloading from our Activision BBS or any of our online
locations. It might also be located on your local BBS or other online services.

Controllers
Mercenaries supports a wide variety of input devices. Please consult or refer
to the “Cockpit Controls” section for further details.

Troubleshooting

In a Help file, we have compiled extensive information on compatibility
issues and solutions. This is an extremely valuable resource that should be
consulted first in the event you experience any difficulty running this game.
The HELP.TXT file can be viewed with any text editor. To access the latest
information and assistance on Mercenaries, please download the
Mercenaries Update document from one of the Activision online forums.




How to Install the MS-DOS Version

1. If in Windows, exit completely out of Windows to get the DOS prompt.

2. Insert the Mercenaries CD into your CD-ROM drive (for these instructions,
we will assume that your CD drive is drive D:).

2 e

At the DOS prompt, type D: and press Enter.

At the D:\ > prompt, type CD\DOS and press Enter.

At the D:\>DOS prompt, type INSTALL and press Enter.

Follow the on-screen instructions carefully. Here are the basic steps the

Installer will follow:

A. GENERAL NOTES
« To abort the installation process press Ctrl+X. If you do so, make sure

Ms-D0S

to delete the Mercenaries directory and its subdirectories, if created.

Memory is checked before installing. You will need 6.9 MB of RAM to
run Mercenaries. |f you get the warning message that you are below
the required amount, you will probably be able to install anyway. At the
end of the installation process, you will be given the opportunity to
create a boot disk to help in freeing up more memory.
Your hard disk drive space is checked for sufficient room to install.
Mercenaries requires a minimum of 62 MB to 150 MB of free
uncompressed disk space, depending on the installation option you
select.
A VESA video driver is checked for since it is required to run
Mercenaries.
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* If you have any trouble with the installation, please consult the
README.TXT file.

B. CONFIGURING SOUND DEVICES

In order to enjoy the audio component of the game, you will need to
select your sound device for digital audio. The installer will attempt to
detect your sound configuration automatically and select the appropriate

drivers. However, on some systems you may need to choose your sound

card manually from the list provided. The Installer will then try to verify
the presence of that sound card in your system. If your sound card is
not shown and is 100-percent Sound Blaster-compatible, you should be
able to select the Creative Labs Sound Blaster or 100% compatible
driver to hear sound and music in the game. When you are finished
selecting the proper sound devices, select Done and press Enter.

. CREATING A BOOT DISK

After installing, you will be asked if you wish to make a boot disk. This

procedure requires that you insert a high-density disk into your A: drive.

Please verify that you have created a backup of the contents of this disk,

since this process will erase all data on it. When the formatting process

is complete and you have typed in a volume label for the boot disk, you

\évill be asked if you want to format another; type N for “no” and press
nter.

Note: If you are running the Installer from Windows 95, do NOT create a
boot disk.

15 MsS-DOS




General Troubleshooting
Q: My computer freezes after completing the first mission. What can | do?
A: Try these solutions; one of them should help you.

1. Eject and reinsert CD.

2. Disable joystick by going to the Controller Configuration screen
by pressing the Esc key in the Star Port and selecting COCKPIT
CONTROLS.

3. Disable SMARTDRYV or any other disk caching utilities.
4. Run the game without a memory manager.

View the HELP.TXT file for a more complete list of troubleshooting options.

Performance

Mercenaries has features that were designed to support a wide range of
computers. When you initially configure Mercenaries for play, Mercenaries
will make several default settings regarding which features should be used
and which should be turned off.

The trade-offs are different for each user, so we allow any machine to
run any options, but please keep in mind that the higher the level of detail,
the more demanding the machine requirements.

Mercenaries’ default resolution is 320x200. We recommend this
resolution unless you have a P-150 or above. On Pentium computers,
Mercenaries should run well at 640x480. Video cards also vary dramatically;
many cards are optimized for extremely high performance in Windows, but
can actually be very slow for use in DOS. The best way to determine this is

by running Mercenaries. Start with a resolution of 320x200, and select
whatever options best match your machine’s capabilities and your desire for
realism. Machine and graphics card allowing, move up to a higher resolution
and adjust graphic options until you reach a satisfactory balance.

Try making the following changes to increase the game’s performance
(they will be found within Combat Variables):

Object Textures: Try turning these OFF.
Terrain Textures: Try turning these OFF.
Display Detail: Try switching to LOW.
Object Density: Try switching to LOW.
Chunky Explosions: Try turning these OFF.
Particles: Try turning these OFF.
Shadows: Try turning these OFF.
Multiple Light Sources: Try turning these OFF.
Resolution: Reduce to the next lower resolution if you're
running above 320x200.

Note: The resolution can only be changed in the shell prior to the
fighting simulation.

Some of the changes listed above should be sufficient to get the game

running reasonably on any machine. Other options can be left ON, as their
performance cost is low.

19 Ms-D0S




7. When installation is complete, you will be returned to the directory in
which Mercenaries was installed. To begin your Mercenaries experience,
type MERCS and press Enter. _

Q: Howdo | run Mercenaries for MS-DOS under Windows 95?

A: If you have Windows 95, we strongly recommend you install the
Windows 95 version. If for any reason you wish to install the MS-DOS
version, please follow these steps.

1. Make sure the game’s CD is in the CD-ROM drive.

2. Close all open windows on your screen. You can close a window by
clicking on the close button (“X”) located in the top right-hand corner
of the window.

Also, close programs listed on the Taskbar. Do this by right-
clicking on a program’s button and selecting Close.

3. Double-click on the My Computer icon. In the window that opens,
double-click on the icon for the hard disk drive where Mercenaries
was installed. Look for the Meres application icon. (The icon is a
picture of a window with the name Mercs underneath it.) Double-click
on this icon to start the game.

If the above process does not work for you, click on the Start button,
choose Shut Down and restart the computer in MS-DOS mode. At the
MS-DOS prompt, go to the directory where you installed Mercenaries
(default is \MERCS) and, from the Mercenaries directory, type MERCS
and press Enter to start the game.

MS-DOS 16

Troubleshooting

Please refer to the help file named HELP.TXT for more troubleshooting
information.

Video

Mercenar/es was designed to take advantage of some of the higher resolution
video modes on your computer. The pre-mission launch portion of the
program (i.e., the shell) runs in 640x480x256 SVGA mode, and the simulation
portion of the program runs by default in 320x200x256 standard VGA mode.
The simulation can also run in 640x480x256 mode using an SVGA video card.
In some cases Mercenaries will detect and work with your video card just fine.
However, some video cards may require that a VESA video driver be loaded in
order for the video card to work properly with Mercenaries.

Input Devices (Joysticks, Mice, VR Headsets)

Mercenaries requires a Microsoft-compatible mouse to run. Most mice today
(including Logitech, Mouse Systems and Kensington) are Microsoft-
compatible. In order for the mouse to work properly in Mercenaries, a mouse
driver must be loaded before running the game. The mouse driver must also
be fairly current and VESA-compatible. Contact the manufacturer of your
mouse or the dealer who sold the mouse to you to see if your driver is the
most current available.

17 MS-D0S




Cockpit Controls
To select the input device(s) you'll be using to pilot your "Mech, select
Cockpit Controls from the Esc menu. Here you can select the ones you'll be
using by clicking on them (accepted ones are shown in red). It's perfectly OK
to use multiple devices simultaneously, as long as your computer is happy
with the setup.

Once you've selected your inputs, click on ACCEPT to take your current
configuration into battle.

Novice Control Mode

Select novice control mode if yu would like to use a simplified set of 'Mech
controls. In this mode, the up and down arrow keys move your "Mech
forward and backward rather than tilt your torso up and down. Note that this
is NOT indicated on the keyboard reference card.

Custom Configuration ;
To modify or customize a device, select Custom Configuration. Then, from
the list of devices in the upper-left corner, select the device to which you
- want to map game functions. Only highlighted ones are available. The
selected one will turn red (as a rule, if a button is bright white; you can select
it and if it's red, it is selected). Now select one of the game controls to which
you want to map the device. Lastly, select the specific input (button or axis)
you want placed there. Inputs can be prefaced by modifier keys, and can be
inverted by clicking on the R/L, U/D areas.

Since you can have multiple (duplicate) inputs controlling the same
function, there are multiple pages of controls, starting with Page One. Cycle
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throu_gh the other Controls pages to see the redundancies (instances where
functions have been assigned to multiple keys, switches, etc.).

You can save and load up to four custom configurations, each with its
own name (just click on Current Config and enter a new name). Click on
ACCEPT CONFIG AND EXIT when you're satisfied.

MercNet

From Windows 95:

You can launch MercNet from the MS-DOS prompt in Windows 95 or by
restarting your computer in MS-DOS mode. Simply type MERCNET and
press Enter, making sure you are in the same directory in which you installed
Mercenaries.

Note: To enable audio for MercNet under Windows 95, type SETSOUND in
your Mercenaries directory and press Enter. This will launch the sound
configuration utility.

From MS-DOS:

There are two ways to launch MercNet from MS-DOS. You can launch
MercNet directly from Mercenaries by clicking on the MercNet button in the
title screen. Alternately, MercNet can be launched directly by changing to
your Mercenaries directory, typing MERCNET and pressing Enter.




ACTIVISION Limited 90-day Warranty

Activision warrants to the original consumer purchaser of this computer software product that the recording medium on which the software program is
recorded will be free from defects in material and workmanship for 90 days from the date of purchase. If the recording medium is found defective within 90
days of original purchase, ACTIVISION agrees to replace, free of charge, any product discovered to be defective within such period upon receipt at its Factory
Service Center of the product, postage paid, with proof of date of purchase, as long a s the program is still being manufactured by ACTIVISION. In the event
that the program is no longer available, ACTIVISION retains the right to substitute a similar product of equal or greater value.

This warranty is limited to the recording medium containing the software program originally provided by ACTIVISION and is not applicable to normal wear
and tear. This warranty shall not be applicable and shall be void if the defect has arisen through abuse, mistreatment, or neglect. Any implied warranties
applicable to this product are limited to the 90 day period described above.

EXCEPT AS SET FORTH ABOVE, THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED,
INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND NO OTHER REPRESENTATION OR CLAIMS OF
ANY KIND SHALL BE BINDING ON OR OBLIGATE ACTIVISION. IN NO EVENT WILL ACTIVISION BE LIABLE FOR SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGE RESULTING FROM POSSESSION, USE OR MALFUNCTION OF THIS PRODUCT, INCLUDING DAMAGE TO PROPERTY AND ,
TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR PERSONAL INJURY, EVEN IF ACTIVISION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS AND/OR THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS AND/OR EXCLUSION OR LIMITATION OF LIABILITY MAY NOT APPLY TO
YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

When returning merchandise for replacement please send the original product disks only in protective packaging and include:

1. A photocopy of your dated sales receipt.

2. Your name and return address, typed or clearly printed

3. Abrief note describing the defect, the problem(s) you encountered and the system on which you are running the product.

4. If you are retumning the product after the 90 day warranty period, but within one year after the date of purchase, please include a check or money order for
$10 U.S. (AUD $17 for Australia, or £10.00 for Europe) currency per CD or floppy disk replacement.

5. Certified mail is recommended.

Inthe U.S. send to: In Europe send to: In Australia send to:
WARRANTY REPLACEMENTS WARRANTY REPLACEMENTS WARRANTY REPLACEMENTS
ACTIVISION ACTIVISION ACTIVISION

P.O. Box 67713 Long Island House, 3A P.O. Box 873

Los Angeles, CA 90067 1/4 Warple Way Epping, NSW 2121

USA London, W3 ORQ Australia

(310) 479-5644 United Kingdom Inquiries: 612 9869 0955

Disc Replacement: 0181 742 9400

COPYRIGHT:

The enclosed software product is copyrighted and all rights are reserved by Activision, Inc. It is published exclusively by Activision, Inc. The distribution of this
product is intended for the use of the original purchaser only and for use only on the computer system specified. Lawful users of this program are hereby
licensed only to read the program from its medium into memory of a computer solely for the purpose of executing the program. Copying (except for one
backup copy on those systems which provide for it), duplicating, selling, or otherwise distributing this product is a violation of the law. This manual and all
other documentation contained herein are copyrighted and all rights reserved by Activision, Inc..These documents may not, in whole or in part, be copied,
photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form without prior consent, in writing, from Activision, Inc.
Willful violations of the Copyright Law of the United States can result in civil damages of up to $50,000 in addition to actual damages, plus criminal penalties of
up to one year imprisonment and/or a $10,000 fine. In addition, violations of the Copyright law of other jurisdictions may result in civil damages and, in certain
circumstances, criminal penalties.

© 1996 Activision, Inc.
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Customer Support

Before contacting customer support, please consult the technical help file. It contains the
answers to some of our most frequently asked questions and may quickly and easily
provide a solution to your difficulty. If after reviewing the technical help file you are still
experiencing problems, please feel free to contact us through any of the services listed.

So that we can better help you, please be at your computer and have the following

information ready:

1

2
3.
4.

Complete product title
Exact error message reported (if any) and a brief description of the problem
Your computer’s processor type and speed (e.g. 486 DX2/66, Pentium 90...)

Video and sound card make and model (e.g., Diamond Stealth 64 video,
Soundblaster 16 sound...)

Online
You may contact a customer support representative through the following online
services (available in English only):

Services with Activision Forums, E-Mail and File Library Support

« Microsoft Network: From any MSN window, pull down the Edit menu and select
Go To and then Other Location... At the prompt, type “Activision” and click OK.

« America Online: Use keyword “Activision” to locate the Activision forum.
» CompuServe: 76004,2122 or [GO GAMBPUB]
« Activision BBS: (310) 479-1335 Up to 28,800 Baud; Settings: 8 Bits, No Parity,
1 Stop Bit (8, N, 1)
Services with E-Mail Support
* Prodigy: ACTI10B
* GEnie: ACTIVISION
Internet: support@activision.com or http://www.activision.com
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In the U.S.

Fax (310) 479-7355, 24 hours a day
FaxBack (310) 473-6453, 24 hours a day
Mail Activision, Customer Support, P.0. Box 67713, Los Angeles, CA 90067

Phone  Call our 24-hour voice-mail system for answers to our most frequently
asked questions at (310) 479-5644. Or contact a customer support
representative at the same number between the hours of 9:00 a.m. and
5:00 p.m. (Pacific Time) Monday through Friday, except holidays.

In the U.K. & Australia

Phone
In the U.K., please call 0990 143 525.
In Australia, please call 1902 962 000.

If you have any comments, questions or suggestions about this game, or any other Activision
product, you can contact us in the U.K. on 0181 742 9400 between the hours of 1:00 p.m. and
5:00 p.m. (U.K.time) Monday through Friday, with the exception of holidays, or contact a
customer support representative through our online services.

For Technical Support and Customer Service in areas not listed, please
contact your local distributor or Activision via online. (Please note,
online support is in English only.)
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